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Learning Objectives 
 Learn how to start a structural design project from scratch. 

 Discover how to model analytical lines and areas in Revit, and then design and analyze in SOFiSTiK 
FEA. 

 Discover how to easily assemble shop drawings. 

 Learn how to optimize your design workflow. 

Description 
In this class we will show the whole Building Information Modeling (BIM) workflow, from the design and 
analysis phase, passing from modeling to delivering drawings. Traditional workflows suffer from loss of 
information and lack of coordination causing a lot of rework.  We will show you how to model a project 
in Revit in order to be useful for design and analysis; how to place loads and then export the analytical 
lines and areas to SOFiSTiK FEA; and how to analyze and design the structure and to use the results to 
place rebars in the concrete. Finally, the client needs drawings, so with some tools from SOFiSTiK we will 
show how to derive 2D drawings sheets from the 3D model. In this session we will use as an example a 
20-story building. We will start with Revit for the first design phases, then use SOFiSTiK FEA for the analysis 
and design. Finally we create 3D rebars using design results and will produce drawings sheets.   

Your AU Experts 

Juan Carlos holds a Major in Civil Engineering by Anahuac University, Mexico City, with a Minor in 
sustainable development and a CAPM title. Juan has six years of experience in project management and 
construction. He started working at FCC SA. Four years ago, he joined the BIM department at ICA, the 
largest construction company in Mexico. At ICA he was in charge of advising the clients in bim 
management strategies. In May of 2014 he was invited to the Autodesk NAC3 event. At the end of 2014 
he co-found The BIM Group, a company dedicated to innovate the construction industry in Mexico, 
implementing BIM and applying other VDC technologies. He works closely with the structural design 
departments and the survey areas, innovating new ways of delivering more information in less time to the 
customers. Nowadays The BIM Group owns a portfolio of 1.3 billion dollars in projects. He is a proudly 
Autodesk Gunslinger since 2014. He has a passion for sports cars and enjoys going to the beach.  

Email: juancarlos@tbg.mx 

After receiving his diploma in structural engineering at Technical University in Munich, Thomas Fink has 
worked in structural engineering and software development for over 30 years. He is co-founder and CEO 
of SOFiSTiK AG, a leading German supplier of software for analysis, design, and detailing. He was on the 
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board of the German section of buildingSMART for more than 10 years, and chaired the working group 
“innovations” of the Bavarian Chamber of Building Engineers. Whenever he has time, he loves to fly 
balloons and to sail.  

Email: thomas.fink@sofistik.de 

Learn how to start a structure design project from scratch. 

Getting Started. 
Some consideration for this Lecture:  

The example of the lecture is based on the US ACI-318M-08 code and was adapted to the Mexican Code 
2004 (Reglamento de Construccion del DF y sus Normas tecnicas Complementarias ).  

For this Lecture we will not take into account the foundations (at the end Sofistik only use them as a 
support for calculating) and we will only use fixed supports.  

For this example we are using Sofistik SSD 2016 and Revit 2016, you can download them from: 
http://www.sofistik.com/en/support/ and http://www.autodesk.com/products/revit-family/free-trial 
respectively. 

This lecture is a testimonial of the experience that we have acquired, the good practices of these softwares 
and some tips and tricks that we would have liked to know.   
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Setting a New Project in SOFiSTiK.  
There are two ways to start a new project in SOFiSTiK, from Revit or from SOFiSTiK FEA.  

The best practice is to open SOFiSTiK SDD and click on New Project. 

It will open the following window:  

 

FIGURE 1: STEP 1 OPENING A NEW PROJECT IN SOFISTIK 

In this window you can set all the parameters that you need.  

It´s important that you save the file in an individual folder, as Sofistik generates many files. You can name 
it as you want.  

Then you have the opportunity to select a country and a code. If by any chance you don’t find yours, don’t 
worry, Sofistik allows you to introduce the software code and adapt it to your needs. In this example, as 
I’m from Mexico, and there is no code program for Mexico, I will use the US ACI-318M-08. This code is the 
most similar to the Mexican Code.  
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The following images show the preliminary settings in order to start a project.  

 

FIGURE 2: STEP 2 OPENING A NEW PROJECT IN SOFISTIK 

Beware to change the Preprocessing to Revit – Graphical Preprocessing.  

Now you have set your Sofistik Project.  

The next step is to start modeling your Project.  
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To do this you have to open Revit within Sofistik. To do this look for Revit: GUI for Model Creation.  

 

FIGURE 3: STEP 1 OPENING REVIT USING SOFISTIK 

Tip: if for some reason Revit doesn’t open or an error appears, you probably have a wrong path for 
Revit.exe define. To fix this go to SOFiSTiK/User Option, search for Revit: GUI for Model Creation and click 
on Paths/General. Change the path to the current location of the Revit.exe in your computer.  

 

FIGURE 4: STEP 1 CHANGE OPENING PATH 
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Modeling.  
Once Revit is opened you can start a model the traditional way. For me, the easiest way to start modeling 
is sketching the grids and levels. As you know, grids and levels are very important in Revit, so please be 
careful.  

Next, you can follow two workflows (it depends on the type of information you have).  

If you are lucky and manage to have a BIM model, you can start reviewing the model and the families and 
then export this model to SOFiSTiK.  

If not, you can always link a CAD file and start tracing beams and columns.  

Tip: you can use an existing model and export it to SOFiSTiK.  

The First Draft. 
Order is the mother of all good models, and for designing is crucial to have order. The names of the 
families and types are going to be very important.  

I suggest to use the following format. 

For the Family:  

A Prefix: S (for Structure)  

Material: Concrete 

Description: Beam 

And for the type:  

Name: T-1 

Dimensions (in centimeters): (90X40) 

Example.  

 

FIGURE 5: FAMILY PROPERTIES 

This way we can know the element properties without going to the type properties (Structural Concrete 
Rectangular Beam, named T-1 that is 90 cm height and 40 cm width.  

The next step is to start modeling. For this I don’t have any recommendation, I´m sure you are better than 
me doing this.  
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Using the “Template” in Revit.  
We have made a special Template in Revit that contains certain View Templates that can help you model 
and visualize the Analytical Lines.  

In order to easily visualize the Analytical Lines we are going to use the 05 Analytical Model 3D View 
Template. This Template shows the Analytical Lines and also the geometry in transparency. The Analytical 
Lines has a filter applied in order to see the beginning, the middle and the end of the Analytical Line, this 
will help us to see if all our lines are connected as we expect.  

 

FIGURE 6: COLUMN WITH ANALYTICAL LINE 

Discover how to model analytical lines and areas in Revit, and then design and analyze 
in SOFiSTiK FEA.  

Analytical lines.  
How to view and manipulate the analytical lines.  

I’m sure that every one of you has created analytical lines without noticing. Yes, they are there. In order 
to activate them you have to enter the Visibility Graphic Menu (short cut “V+V”) and go to the third TAB 
named “Analytical Model Categories”, then press ALL and turn them ON. Press OK. The final step to see 
the Analytical Lines is to turn the Visual Style into Wire Frame.  

 

FIGURE 7: VISIBILITY GRAPHICS/ANALYTICAL MODEL CATEGORIES 
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Tip: Use the 05 Analytical Model 3D View Template. 

Sometimes the Analytical Lines are not in the desired location. To move the Analytical Line you have 
several methods. If it´s just a small adjustment you can select the Analytical Line and then, select the 
correct alignment.  

 

FIGURE 8: ADJUSTMENT OF COLUMN ANALYTICAL LINE 

Tip: you can adjust also the beams and floors.  

If you have to make a major fix, select an Analytical Line and then, in the Modify tab, select Analytical 
Adjust. This way you can adjust the line to the desire location.  

 

 

FIGURE 9: STEP 1 ACTIVATE ANALYTICAL RESET 
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FIGURE 10: STEP 2 ADJUSTMENT OF BEAM ANALYTICAL LINE 

 

FIGURE 11: STEP 3 ADJUSTMENT OF BEAM ANALYTICAL LINE 

Note: only structural elements can have Analytical Lines.  

Setting Foundations (Boundary Conditions).  
This step is very easy. If you have used a Foundation Family, by default a support appears when we you 
activate the Analytical Lines.  
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FIGURE 12:  PILE WITH BOUNDARY CONDITION 

If you didn’t model any Foundations you can still add Boundary Conditions to your model. In order to do 
this, go to the Analyze tab in the Ribbon and click on Boundary Conditions.  

 

 

FIGURE 13:  ANALYZE TAB 
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Add the Boundary Condition at the end of the Columns.  

 

FIGURE 14:  BOUNDARY CONDITION FOR COLUMN 

You can change the way the boundary behaves in its properties.  

 

FIGURE 15:  CHANGING BOUNDARY CONDITION STATE 
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You can select: Fixed ( ), Pinned (  ), Roller ( ) or even a user defined boundary 
conditions.  

For this example we will use a Fixed Boundary.  

Setting the Load Cases.  
To introduce load cases, go to the Analyze Tab /Analytical Model/Load Combinations.  

 

FIGURE 16: REVIT RIBBON, LOAD CASES & LOAD COMBINATIONS 

You have to enter the load cases in Revit in order to have them recognised by SOSFiSTiK.  

 

FIGURE 17: STRUCTURAL SETTINGS, LOAD CASES 

Setting Loads.  
You can set a load in a 3d view or in a plane view.  

 

FIGURE 18: REVIT RIBBON, ANALYZE TAB 
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Select the Loads icon and then select the type of load you want to insert: 

 

FIGURE 19: LOADS  

Then you have to add the value of the load. To do this you have to select the load and enter the desired 
value in the properties dialog.  

 

FIGURE 20: LOADS PROPERTIES 

Here you can also set the Load Case for each load.   

Tip: it´s easier to set loads in a 3D view, just take into account the work plane you are using.   

Mapping Materials.  
Materials, Families and Load Types in Revit can´t be mapped to Materials, Cross Sections and Actions in 
finite element software. Therefore SOFiSTiK offer the possibility to map this information to the 
corresponding definitions in their software.  

 

FIGURE 21: SOFISTIK FEA EXTENSIONS.  
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To map Materials, click on Material Mapping.  

 

FIGURE 22: SOFISTIK MATERIAL MAPPING.  

SOFiSTiK makes an intelligent mapping, but if you are not satisfied with the result you can always change 

some material settings by clicking .  

 

FIGURE 23: SOFISTIK DESIGN CODE MATERIAL.  

In this dialog box you can change properties, strength and bedding.  
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Mapping Sections.  
To map Sections click on Section Mapping. The following window will open:  

 

FIGURE 24: SOFISTIK CROSS SECTION MAPPING.  

SOFiSTiK also makes an intelligent mapping for sections. You can also change the section if you don’t 
agree with the one SOFiSTiK proposed.  

Mapping Loads.  
Last step before exporting to SOFiStiK is to map the loads. To do so you have to click on Action Mapping.  

 

FIGURE 25: SOFISTIK FEA EXTENSIONS.  

A similar window will open.  

 

FIGURE 26: SOFISTIK ACTION MAPPING.  
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Export to SOFiSTiK.  
As for this step you are all set to export all the relevant information from Revit into SOFiSTiK.  

 

FIGURE 27: SOFISTIK EXPORT.  

In the export settings you can select many options. For example, you can only export a part of your system, 
or you can export a subsystem. Subsystems are commonly used to analyze slabs as a 2-D system. SOFiSTiK 
automatically created rigid or elastic supports where columns or walls have been cut.  

An important parameter to be set is the Mesh Density. As it says the Mesh Density is how precise we want 
our models to be calculated. Be aware that if the density is very high, the calculations will take longer.  

After setting the parameters click OK.  

Use the SSD Main System Button to open SOFiSTiK.  

 

FIGURE 28: SOFISTIK FEA EXTENSIONS.  

Tip: I’m pretty sure that you will get an error in your first export. Try to find the Analytical Line or the 
element that is causing the problem.  If you can’t, try to export less elements. I extremely recommend to 
start by modeling a simple frame (columns and beams) and start to see how the model behaves in the 
export.  
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SOFiSTiK Overview.  

 

FIGURE 29: SOFISTIK FEA OVERVIEW.  

Setting the Load Cases Combinations.  
In order to do this you have to add a task into SOFiSTiK. To add task, simply make right click on the Project 
Browser and add a task.  

 

FIGURE 30: SOFISTIK INSERT NEW TASK.  

SOFiSTiK Project Browser 

3D Viewer 

Tools 
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After inserting the task double click on the Loadcase Combination Manager. A window like this will 
open: 

 

FIGURE 31: STEP 1 SOFISTIK LOADCASE COMBINATION MANAGER.  

Here you can set the factor for the unfavourable, the favourable cases and the load combinations.   

 

FIGURE 32: STEP 2 SOFISTIK LOADCASE COMBINATION MANAGER.  
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Getting the Design Spectrum into SOFiSTiK.  
Here is when it starts to become a little complicated for those who are not familiar to coding. In many 
cases it pays off to learn this, as you can reuse your work for upcoming projects.  

There are two ways of doing this. The easiest one and the hard one.  

The easiest way is to simply add a task (see image below).  

 

FIGURE 33: STEP 1 SOFISTIK INSERT NEW TASK.  

Double click on the task.  

 

Spectra Graphic 
Values 
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FIGURE 34: SOFISTIK EARTQUAKE & SPECTRUM SETTINGS. 

Fill the dialog box with the appropriate values.  

Important note: you can modify the spectra with your own values. Please see the hard way.  

The hard way.  

You may want to determine the function outside the software. A good recommendation is to calculate 
the spectra in Excel and then copy and paste it into SOFiSTiK. To do this task you have to add a white 
Teddy Editor Task.  

 

FIGURE 35: INSERT TAKS EXT EDITOR (TEDDY). 

Tip: you can sort your task by creating Groups (right click, add group).   
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Next the code tells SOFiSTiK what to do.  

 

FIGURE 36: SPECTRA CODE IN SOFISTIK 

These values are used by SOFiSTiK to create the spectrum of design.  

Tip: you will find a SOFiSTiK template file in the AU cloud for your use.  

Accidental Eccentricity.  
You can also calculate Accidental Eccentricity. This can get a little tricky. In order to make this you have to 
calculate the maximum length in the X axis and the maximum length in the Y axis for all levels. After that, 
we have to create a section box for every story and obtain their coordinates. With this information and a 
little bit of code we can tell SOFiSTik how to calculate all building eccentricity. This will works Earthquake 
analysis (Dynamic Analysis).  
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FIGURE 37: ACCIENDTAL EXXENTRICITY CODE IN SOFISTIK, MAXIMUN LENGTHS 

X axis Y axis 
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FIGURE 38: ACCIDENTAL ECCENTRICITY CODE IN SOFISTIK, SECTION BOX COORDINATES AND ACCIDENTAL ECCENTRICITY 

CALCULATION  

Running the Model.  
After a couple of iterations you will have fulfilled all code requirements. 

To run the model using all analysis, give right click and Calculate All.   

Go and get a cup of coffee.  

Tip: SOFiSTiK runs faster if you have the file saved in the local disk. Using a server will take long time to 
run. SOFiSTiK prefer SSD hard drives.  

Reviewing the model.  
SOFiSTiK has a very wild variety of reports. You can review the model results using a tool called WinGraf (

). You can create a report by inserting a new task and select WinGraf.  

Some examples of reports are the Story Drift and the Base Shear. You can easily view this reports. You can 
also review the 3D Model.    

Section box coordinates 

Code for calculating  

Accidental eccentricity 
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FIGURE 39: SOFISTIK 3D ANIMATION 

 

Designing the Elements (Columns, Slabs and Framings).  
You can use WinGraf to visualize all the results (Moments, shear).  

Discover how to assemble easy shop drawings.  

Returning information to Autodesk Revit.  
Returning the reinforcement to Revit is very fast. After running SOFiSTiK all the result will be saved in the 
database. In Revit you can create reinforcement with the information saved in the database. In order to 
bring it back you have to use SOFiSTiK you have to open Revit through SOFiSTiK.  
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Creating Rebar with Reinforcement Generation.  
To generate rebar you have to use SOFiSTiK Reinforcement Generation Tool.  

First you have to select the elements that you want to reinforce.  

Open Create.  

 

FIGURE 40: SOFISTIK REINFORCEMENT GENERATION TOOLS 

Select the database and the design case.  

 

FIGURE 41: STEP 1 SOFISTIK CREATE REINFORCEMENT 

You can set your own rules for reinforcement and save this files for futures projects or organizational 
templates.  

 

FIGURE 42: STEP 2 SOFISTIK CREATE REINFORCEMENT 
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Select the rebars types you want to use in order to fulfill required reinforcement.  

 

FIGURE 43: STEP 3 SOFISTIK CREATE REINFORCEMENT 

 

FIGURE 43: STEP 4 REVIT BEAM REINFORCEMENT 
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You can check the reinforcement generated vs the rebar required.  

 

FIGURE 44: STEP 1 SOFISTIK CHECK TOOL  

 

FIGURE 44: STEP 2 SOFISTIK CHECK TOOL (RED REQUIRED, BLUE ACTUAL REBAR IN BEAM).  
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Using SOFiSTiK Reinforcement Detailing to make 2D drawings.  
To finalize we will show you a small live demo of how to easily generate rebar using the SOFiSTiK tools 
and how to detail a beam.  

 

FIGURE 42: SOFISTIK REINFORCEMENT DETAILING TAB 

SOFiSTiK Reinforcement Detailing is a very powerful tool, you can make from rebar detailing, passing to 
schedules, to sending BVBS files to rebar bending machines.  

Tip: for more information of Reinforcement Generation and Detailing, please refer to:  

http://aucache.autodesk.com/au2014/sessionsFiles/5174/4991/handout_5174_DE5174.pdf 

http://aucache.autodesk.com/au2013/sessionsFiles/1669/1035/presentation_1669_au2013_SE1669_16
x9.pdf 

Summary.  
Using Revit and SOFiSTiK correctly in your workflow can potentiate your BIM production. We 
demonstrated that SOFiSTiK can be adapted to several design codes even if they are not available from 
the factory.  SOFiSTiK FEA is a very powerful general tool. To take best use out of it, you will have to pass 
a learning curve. As it is an open system with many interfaces available, it can be customized to different 
problems. Your input files can easily be used for similar projects in the future. 

The possibility to use your BIM Model for reinforcement design to generate and check your design against 
requirements has a huge potential to streamline your processes and to help you producing better quality 
at less cost. 

 


